WooCommerce (from 5.7 to 8.8.X)

@ version upgrades

We strive to bring the best quality to our modules and we invite you to use the latest version to benefit from it.

CMS Versions Module version

5.7108.8.X 2.4.0

Latest changelogs :

13/03/2024: Updates incorporating new features in the latest WooCommerce version for Axepta BNP Paribas.
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Introduction

AXEPTA BNP Paribas allows you to accept payments using different payment methods. Each of them offers different possibilities, through an e-
commerce platform, such as:

® Standard payment

® One click payment
® Recurring payment.

Prerequisites

Required php version of the server should be :



PHP Versions
Woocommerce Versions

71 72 74 81
57459

6024756 v
7.738.8X

Supported - Not supported v = Recommanded version

The plugin supports versions from 5.7 to 8.8.X

Multi-store or multi-currency configrurations are not possible with this module.

Installation of the plugin
The installation of the plugin requires the following steps :
1) Go to the "Plugins" tab from the left side of the backoffice and click on « Add »

y Dashboard

Posts

Media

Pages
Comments
WooCommerce
Products
Analytics

Marketing

¥ Appearance

& Plugins 5

Installed Plugins
Add New

Plugin Ed

On the next screen, click on "Upload plugin" and upload the plugin. Once uploaded, click on "install now".



Add Plugins

I Heads up! Facebook for WooCommerce will soon discontinue support for WooCommerce 4.1, Please update WooCommerce to take advantage of the latest updates and features.

If you have a plugin in a .zip format, you may install it by upleading it here.

Parcourir... | Aucun fichier sélectionné.

Once the plugin installed, you can disable or delete it.

2) Back to "Plugins" > "Installed plugins" from the menu on the left of the screen, find the "Axepta Online BNP Paribas" plugin by scrolling through the list
or searching for "Axepta" on the search bar.

Toutes () | Activées (2) | Désactivbes () | A mettre 3 jour %‘

Actions groupées v || Appliquer 1 elément
Extension Jeserption
Axepta Online BNE Paribas axepta Online Me POST WonCommerce
Lol Version 1.04 | Par Ouadra atice
Extension Description
Actions groupées v || Appliquer 1 dlémem

Global configuration of the plugin

To create a new configuration, go to the tab "WooCommerce" > "Settings" on the left side of the screen.

Click on the tab “Axepta configuration” to display the list of all your configured accounts and add others.

Dashboard WooCommerce / Settings / Axepta Configuration

Help ¥

General  Products | Shipping  Payments  Accounts &Privacy  Emails | Integration  Advanced AxeptaConfiguration | Liste des abonnements avec Axepta

Comptes Axepta

N Compe Merchand 1D Pays stout
1 SNP_Quadra_tbr EUR S Tous les pays ©
2 NP Quadra tbr EUR S Germany e )

Settings

Statu

To add a new account, click on the "Add account” button (Ajouter un compte)

Ajouter un compte

You should, then, fill the required data provided by BNP Paribas and click on "Save".



Comptes Axepta

\Cet ID est fourni par Axepta

*Entrez votre Marchant ID |

ournt par Axepta

*Entrez votre mot de passe de |
cryptage

lLa clé "HMAC KEY" est fournie par Axepta

*Entrez votre HMAC-KEY |

bt 15 d'ackii s "
*Entrez votre clé d"activation La clé d'activation est fournie par Axepta

Enregistrer les paramétres

Once the configuration saved, you can click on "configuration" to manage the different payment methods and functionalities you would like to activate on
your shop.

Mes méthodes de paiements

*CB/VISA/Mastercard ®) Oui Non

*AMEX ® Oui Non

*Sofort ®) Oui Non

*Paypal ® Oui Non

*Cetelem 3X Non disponible dans votre offre, veuillez contacter Axepta.
*Cetelem 4X Non disponible dans votre offre, veuilez contacter Axepta.
*Devise autorisée

“Pays riofs Tous les pays

The payment methods that are displayed are the ones corresponding to your activation key.

The payment methods in grey correspond to those that are not part of your offer. You have the possibility to visualize the complete offer in order to see
everything that the Axepta module proposes.

You can now configure your account options.

Currency :

The currency indicated is the currency of your activation key. This data cannot be modified, it is only shown as an indication for the management of the
account.

Please note that you must activate the currency beforehand in the woocommerce backoffice. To do this, go to "WooCommerce" > “Settings” > "General"
and find the tab "Currency options' .



Currency options

The following options affect how prices are displayed on the frontend.

Currency [2] Euro (€) -
Currency position @ Left -
Thousand separator 2]

Decimal separator @ ,

MNumber of decimals @ - 5 s

Country :

You can choose to activate the account either in all countries or in manually selected countries by holding down the ctrl key.

*Devise autorisée =7 Devise sélectionnée dans la configuration de Woocommerce.
*Pays autorisés Tous les pays Sélectionnez le pays que vous souhaitez lier d votre compte

3DSecure and exemption management :

The 3DSecure is still activated on your store, you can nevertheless activate the "Exemption request” option which will allow you to request an authenticatior
exemption for the cardholder during a simple payment on your merchant site.

To enable exemption requests, please select "Yes" in the "Exemption request" box to disable please select "No"

Options de Paiement

chand contre le motif d'impayés contestation du porteur. En cas de
I,

r plus de

Oui => L'utilisation de l'authentification 3D Secure permel de proteger le mar
demande dexemption d'authentification par le marchand, ce dernier perd ce transfert de responsabilité dans la majorité des cas (pou

*3D Secure Exemption

te ef Matrices 30-Secure - Dociment

détails : Transfert de respons

Oui

@ Non

ion Axepta BNP Paribas — Aver

fontant maximal pour lequel desactiver le 305
/




If you wish to activate exemption requests you must then fill in the "Amount” box which corresponds to the maximum amount that will trigger an exemption r
equest. Above this amount, the exemption request will not be triggered.

Options de Paiement

Oui => L'utilisation de l'authentification 3D Secure permet de protéger le marchand contre le motif d'impayés contestation du porteur. En cas de

*3D Secure Exemption ' : : “ : :
demande dexemption dauthentification par le marchand, ce dernier perd ce transfert de responsabilité dans la majorité des cas (pour plus de

details : Transfert de responsabilité et Matrices 30-Secure - Documentation Avepta BNP Paribas - Avepta).

®) Oui

Non

}‘40.'1:6.'1! maximal pour lequel désactiver le 3DS

Attention : Please note that the use of 3D Secure authentication protects the merchant against the reason for unpaid invoices "holder dispute”. In the event
of a request for exemption from authentication by the merchant, the latter loses this transfer of responsibility in the majority of cases (For more details: Liabi
lity shift and 3DS Matrix - Documentation Axepta BNP Paribas - Axepta). This is a request for exemption, this does not mean that it will be granted systema
tically by the issuer of the cardholder's card. Exemption requests only work with transactions paid in Euro.

Known error:  Since switching to 3DSV2, it is imperative to send the parameter "BillingAddress" to Axepta to make a payment.
This parameter contains the following data:

- City

- Country

- Billing Address 1
- Postal Code

These fields are mandatory for the module to function properly and must be present in the payment form:

— >

Cas d'une erreur recurrente:
Parametre BillingAddress Invalid

Ce formulaire
est incomplet,
Depuis le
passage vers le
3DSV2,
certains
champs sont
devenus
obligatoires: Il

CONTINUER

— |

~

s'agit

—>

@ ville

@ Pays

@ Adresse de facturation 1
@ Code postale

—

Avec ce type d'erreur, il faut
bien vérifier dans la boutique
du client si le formulaire
contient toutes informations

Ces données sont
obligatoires pour faire un
paiement en 3DSV2

One-click payment :

This option allows you to activate the oneclick payment via registration of the payment method by the user in his customer account.

Subscription :

This option allows you to activate the subscription payment on the shop.


https://docs.axepta.bnpparibas/display/DOCBNP/Liability+shift+and+3DS+Matrix
https://docs.axepta.bnpparibas/display/DOCBNP/Liability+shift+and+3DS+Matrix

Rendering mode :
The display of the payment page is possible in 2 ways with the plugin:

® Redirection => External redirection of the user to the payment page
* iFrame => Displaying the payment page on the shop in an iFrame

Capture method :
This option allows you to choose the payment capture method:
® Automatic => The capture will be done automatically in the night.

® Manual => After a defined time, you can choose just after choosing this option the delay before the capture (Delay in hours before capture
(integer between 1 and 696)).

Options de Paiement

“Activer le 3D-Secure @ ® oui

Montant minimum pour lequel | ontant minimum pour jouter (e 3DS
activer le 3D-Secure

=Activer le paiementenun clic  © (@) Oui

*Activer I'abonnement ® @ oui

Page de Paiement

*Sélection et saisie des données

! isie des Redirection -
bancaires lors d'un paiement

UEladace Capturer le paiement automatiquement (par défaut) -

"Activer ce compte Activer

Your account is now configured.

You can configure as many accounts as your BNP Paribas contract allows. To add an account, you must go to "Axepta payment configuration" and do the
same operations. The list of accounts will be updated with each new registration.

You can also disable a configuration.

The render of the checkout page



Billing details Your order

First name Last name
Product Subtotal
KANALE DEMBA roduc ubtota
Company name (optional) IPHONESx/1 20.00€
Subtotal 20,00€
Country / Region
Shipping Livraison gratuite
Belgium -
Street address ” Total 20,00€
11 PLACE DE la gare
Apartment, suite, unit, etc. (optional) © BNP_Quadra_txbr_EUR_t
Postcode / ZIP *
Bank cards.
18001 o
-
Town /City Bancontact
CRACOVIE
o Sofort
Phone
0134455555

Email address *

ecommerce@quadra-informatique.fr

Ship to a different address? a]

More payment options -

Order notes (optional)

O Register my card for future payments.
Notes about your order, e.g. special notes for delivery

Vos données personnelles seront utilisées
pour le traitement de votre commande,
vous accompagner au cours de votre
visite du site web, et pour d’autres raisons
décrites dans notre privacy policy.

Pay

Payment methods are displayed on a framework for 6 proposals. Additional payment methods can be accessed by selecting "More payment options”,
which only appears if necessary. The "One-click" option is activated here to offer the registration of the card of the user.

The rendering of a redirected payment page

AXEPTA

BNP PARIBAS

English &

my store

YOUR ORDER
MWZA4PAPO
SHOPPING CART

Total number of items : 1

Please enter your card data:

1x Pull imprimé colibri Card number

SHIPPING TO
KANE KANE MM
123 RUE DU TEST

e
TOTAL AMOUNT
34.46 EUR
& Cancel and return to vebsite g Wastercard

The rendering of an iFrame payment page



Home Boutique Mon compte Page d’exemple Panier Validation de la commande

A Home - Validation de la commande > Pay for order

Pay for order

ORDER NUMBER:

223

DATE:
6 March 2023

TOTAL:
8,00 €

PAYMENT METHOD:

Please enter your card data:

AXEPTA

visa [
=

1D Check

Payment modes configuration

One-off payment

To activate the one-off payment, you must go to "WooCommerce" > "Settings" > "Payments" on the left side of the screen, and check "Axepta".

General  Products | Shipping = Payments  Accounts&Privacy  Emails | Integration = Advanced  Axepta Configuration | Liste des abonnements avec Axepta

I Facebook for WooCommerce is almost ready. To complete your configuration, complete the setup steps. [x]

I Heads up! Facebook for WooCommerce will soon discontinue support for WooCommerce 4.1. Please up date WooCommerce to take advantage of the latest updates and features, o

Payment methods

Installed payment methodis are listed below and can be sorted to control their display order on the frontend.

Method Enabled  Description

v Direct bank transfer Take payments in person via BACS. More commonly known as direct bank/uwire transfer
AV Check payments Take payments in person via checks. This offine gateway can also be useful to test purchases.
A v Cashon delivery Have your customers pay with cash (or by other means) upon delivery.
A v payPal PayPal Standard redirects customers to PayPal to enter their payment information
A v Axepta—Payer avec Axepta Online BNP Paribas «©
N Paiement par abonnement avec Axepta — Paiement par abonnement sécurisé avec Axepta Online BNP [ o)

Paribas

When you click on the button on the right side, you can configure the payment by checking the "activation" box.



You can also enable the logs (this can help the support to analyse transactions).

Axepta
Activation (v] Activer le paiement simple
Activer les logs (] Activer les logs

Save changes

One-click payment

This functionnality allows your customers to save their payment methods data so that they can pay faster the next time.

You need to make sure that this option is enabled in your configuration ("WooCommerce" > "Axepta Configuration" > "Configuration" of the MID of your
shop.

Options de Paiement

*Activer le paiement enun clic @ ®) Oui

7 Non

The customer will be able to manage his saved cards in his personal account in the “My saved cards” tab :

Accueil Mon compte Page d’exemple Panier Validation de la commande

A Accue Mon compte

Mes cartes de paiements

Aucune carte bancaire enregistrée.
Tableau de

bord

Subscriptions



Enable Subscription

You need to make sure that this option is enabled in your configuration ("WooCommerce" > "Axepta Configuration" > "Configuration” of the MID of your
shop.

*Activer I"abonnement @ (® Oui

MNon

Configuration
When the subscription functionality is enabled, it's possible to configure items to pay by subscription.

To do so, you should configure every item that can be paid by subscription, individually. Go to the menu on the left side of your screen > "Products” and
search for the product you would like to configure by writing its name or scrolling the list.

To pay for a subscription product, it is mandatory to have a customer account. For guest mode customers who have a subscription product in their cart, the
creation of a customer account is requested before making the payment.

On the product sheet (when you click on the name of the product), you can go to the "pay by subscription" tab on the bottom right side of the screen.

And you can configure the following information:

Type : indicates if the item will be paid by subscription or standard payment.

Periodicity : indicated the type of subscription (monthly or daily)

Interval occurrence : Number of times that the payment will be proceeded. If this value is not filled, the occurrence is unlimited.

Recurring amount : Indicated the amount of the item in subscription, so this value can be different from the initial price of the item. This value
represents the value that will be withdrawn in the future transactions.

Paiement par abonnement i

Type

Paiement par abonnement b |

Péricdicité
K |

Type d'ocourence

| honth ~ |

Mombre d'coourences (0 = illimits)

| Mb souhaité occurences |

Montant de I'abonnement

| Montant HT de 'abo |

Subscriptions management

On the tab "Woocommerce" > "Settings" > "Listes des abonnements avec Axepta" , you can visualize all your subscriptions and have access to the
following data :

Customer name
Product ordered
Amount
Periodicity
Order date

Number of payments proceeded



Subscription status

Liste des-abonnements avec Axepta

x®oW
x® W
x® W
x® W
x®o W
x®W
x®W
x®W
X ® W
]
Xx® W

B GBS EY - ER BN -

Available actions in this section are:
Enable a subscription
Disable a subscription
Check détails about an order

Delete a subscription

Actions

vV X ®§

Subscription management (user view / Front office)
The customer can also manage his subscriptions in his personnal account via the tab “My payments with subcription”.

He can also enable/disable any subscription instantly by clicking on the button in the "Action" column.

Tableau de Paiement(s)
Dernier Prochain
bord Statut Produit par Action
Paiement Paiement
abonnement
Your
= V‘ o o )
Lartes ge
pai
b . 3720 Annuler
Abonnements &
el A - Annuler
Téléchargement FRCANE Beanie 20
Adresses active geanie 3/22/20
ctivé Beanie 03/20/20 03/25/20 mité
Account Details Annuler
Déconnexion Désactive Beanie 03/20/20
Beanie 20/2( )3/25/2 Iimité ik
s ) Annuler

The subscription's status will be updated automatically on the backoffice.



nents avec Axepta

Statut

Ac

Payment of delivery costs for recurring subscriptions by the Axepta BNP Paribas module

This feature makes it possible to cover delivery or transport costs on recurring subscriptions, taking into account the delivery zones already configured on

the store.

Product configuration :

Go to the product page of your subscription: in the right column, in the box «Payment by subscription», a field «Subscription shipping costs» appears. This

option is unchecked by default.

+ Créer Voir produit

® @ weplus-bpparibas-wordpress-6-2-2-php8-2... L ]

Modifier le produit
A Articles

07 Médias
M Pages
% Commentaires
) WooCommerce

Avis
&= Produits

Ajouter un commentaire

Tous les produits

Ajouter Aucun commentaire pour l'nstant.

Avis

ail statistiques
€© Marketing
A Apparence
K Extensions @
& Comptes

&~ Outils

Bonjour, TESTEUR TESTEUR [l

Paiement par

N AV 4
abonnement
Type
Paiement par abonnement v
Périodicité

1

Type d'occurence

Jour v

Nombre d'occurences (0 = illimité)
30

Montant de I'abonnement

13

Frais denvoi de Iabonnement [

Configuration of delivery rates for recurring subscriptions :

By checking the «Subscription shipping costs» box, several fields appear, depending on the delivery zones configured on the shop. You can set different

shipping costs depending on the delivery methods and areas.




Paiement par

AW A
abonnement
Type

Paiement par abonnement A
Périodicité

1
Type d'occurence

Jour hd

MNombre d'occurences (0 = illimité)
30

Montant de I'abonnement
28
Frais d'envoi de I'abonnement |+
Méthode Codit (€)

EUROPE / Livraison graturte 0

EUROPE J Boxtal Connect 15
EUROPE / Forfant 8
ASIE / Livraison graturte 0
ASIE f Bootal Connect a5
ASIE f Forfar 10

After entering the shipping prices, update the product to save the changes by clicking “Update” in the “Publish” box at the top of the right column.



Publier M W A

| Prévisualiser les modifications

¥ Etat: Publié Modifier
& Visibilité : Publique Modifier

111 Publhié le : 31 mai 2022 a 16h 59 min

T L
Aodifier

Visibilité du catalogue : Catalogue et
recherche Modifier

Copler vers un nouveay browillon

bettre 3 la corbeille

Control of subscriptions :

To check that the shipping costs have been taken into account, go to WooCommerce > Settings > Subscription list with Axepta. A column "Delivery
charges" appeared with the corresponding amount.

] ] [ e e e e ] ﬂh

Livkr e sboresrmant, s keephs

K
&
- oo s w w W

Transactions management

The complete list of transactions paid with different payment methods is available on the transactions tab : "Woocommerce" > "Transactions" . You will get,
for every transaction, the following information :

Transaction's date
Payment method's brand
Transaction ID

Order's reference



Merchant's Id

Pay ID

XID

Amount

Transaction's type (one-off payment, cancellation, refund, recurring payment...)
Status(success, failure, authorization... )

Response code

Details

Transactions

N* Commanda 1le] CCEwpiny Mentart

500 weuring o success

WRAFLINEL * 2 #c  Tend ‘ada + paymest

13

Raw data detail - Transaction n® 46

r

Facebook for WooCommerce is almost ready. To complete your configuration, co

OK : Successful transaction. Action code can contain information.

TransID : 2A63CIELVKXQP

Code : 00000000

Description - success

Refund/ cancellation

To make a refund, go to "Woocommerce" > "Orders". You will get the complete list of orders.

Orders

Al 33) | Processing (16) | Cancelled (4) | Refunded (1) | Failed (12)

#88 Julien Brouwers

#87 Julien Brouwers

[ Buik Actions |
. Order Date status
O 299 Juen Brouwers - sepim200 canceled

Sep 17, 2020 Processing

Sep 16, 2020 Failed

Once you select one order (by clicking on the name), you will get the following screen :

When you click on "Details" you will have additional information about the transaction (useful to analyze a transaction by the support)




Edit order

I Facebook for WooCommerce is almost ready. To complete your configuration, complete the setup steps.

Heads up! Facebook for WooCommerce will soon discontinue support for WooCommerce 4.1. Please update WooCommerce to take advantage of the latest updates and features.

Order #89 details
Payment via Payer avec Axepta Online BNP Paribas. Customer IP: 159.50.16.162

General Shipping
Date created ddres:
2020-09-17 @[ 163 | 27t
Status
Email address:
Cancelled lien brouners @quadrarinformatique r
Customer: Profle — View other orders = Phone:

0606060606
admin (#1 - julien.brouwers@quadr

tique fr)

- Bonnet €1800 1 €800
tems Subtotal €18,00
Order Total: €18,00

Refund

© This order s no longer editable.

When you click on "Refund", a new tab will appear allowing you to fulfill information about the refund :

= Amount : total amount or partial amount to refund. (The amount indicated can't be higher the total amount)
" Reason : this information is optional.

Restock refunded items: (v
Amount already refunded: -€0,00

Total available to refund: €138,00

Refund €0,00 manually Refund €0,00 via Axepta

You can now validate the refund.

© Refund amount:

© Reason for refund (optional):

Are you sure you wish to process this refund? This action cannot be undone.

Annuler

The transaction is now refunded.



Remizoursement n°108 - 24 mars 2020, 12 h 16 min par gdmin -149,00¢

5,00€

ddoos 000E

Remboursé 146,00€

REMDJursement | 8 Cette commonde nest plus modifiobfe.

And the status is automatically updated to "remboursée”.

Commandes | Alute une cemmande
Tous En cours: (18 Anmdées (3) | R OUTs e Echcwde 3 cher omm de

Actiors groupess v || Appliquer Tourtes les dates - trar 40 slmans

a: - far 2 Echowde

Description of payment methods

Payment methods | Countries Currencies
AMEX All All
CB/VISA/Mastercard = All All

Cetelem 3X FR EUR
Cetelem 4X FR EUR
Cetelem Presto FR EUR
Mastercard/VISA All All

Paypal All All

Sofort Klarna DE, AT, BE, IT, ES, NL, CH, PL | EUR
Alipay CN AUD, CAD, EUR, GBP, HKD, NZD, SGD, USD
Bancontact BE EUR
Boleto Bancario BR uUsD

eNets SG SGD

EPS AT EUR
Giropay DE EUR

iDeal NL EUR
Multibanco PT EUR
MyBank ES,GR, IT EUR

MyClear FPX MY MYR



Paysafecard AAT, AU, BE, BG, CA, CH, CY, | AUD, CAD, CHF, EUR, GBP,
CZ, DE, DK, ES, FI, FR, GB, NOK, PLN, RON, SEK, USD
GE, GI, HR, HU, IE, IT, LI, LT,
LU, MT, MX, NL, NO, NZ, PE,

PL, PT, RO, SE, SI, SK, UY

POLi AU AUD
POLi Nz NzD
Przelewy24 PL EUR, PLN
RHB Bank MY MYR

SEPA Direct debit AT, BE, BG, CH, CY, CZ, DE, EUR
DK, EE, ES, FI, FR, GB, GR,
HR, HU, IE, IS, IT, LI, LT, LU,
LV, MC, MT, NL, NO, PL, PT,

RO, SE, SI, SK, SM

TrustPay Cz CzZK
TrustPay SK EUR
Wechat CN EUR, GBP, USD
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Introduction

AXEPTA BNP Paribas allows you to accept payments using different payment methods. Each of them offers different possibilities, through an e-
commerce platform, such as:

® Standard payment

® One click payment
® Recurring payment.

Prerequisites

Required php version of the server should be minimum 7.1



The plugin supports versions from 3.7 to 5.0

Installation of the plugin

The installation of the plugin requires the following steps :

1) Go to the "Plugins" tab from the left side of the backoffice and click on « Add »
Dashboard
Posts
Media
Pages

Comments

WooCommerce
Products

Analytics

B) Marketing

Appearance
Plugins '5
Installed Plugins

Add New

Plugin Editor

On the next screen, click on "Upload plugin" and upload the plugin. Once uploaded, click on "install now".

Add Plugins

I Facebook for WooCommerce is almost ready. To complete your configuration, complete the setup steps.

I Heads up! Facebook for WooCommerce will soon discontinue support for WooCommerce 4.1. Please update WooCommerce to take advantage of the latest updates and features.

If you have a plugin in a .zip format, you may install it by uploading it here.

Parcourir... | Aucun fichier sélectionné.

Once the plugin installed, you can disable or delete it.

2) Back to "Plugins" > "Installed plugins" from the menu on the left of the screen, find the "Axepta Online BNP Paribas" plugin by scrolling through the list
or searching for "Axepta" on the search bar.



A mettre 3 jour (2) [ =]

1 element
Extension Jescription
Axepta Online BNF Faribas Axepta Online essential POST WooCommerce
CEed e Version 104 | Par a Informatique
Extension Description
Actions groupées v L Appliquer 1 Elément
Global configuration of the plugin
To create a new configuration, go to the tab "WooCommerce" > "Settings" on the left side of the screen.
Click on the tab “Axepta configuration” to display the list of all your configured accounts and add others.
‘WooCommerce / Settings / Axepta Configuration
Help ¥

General  Products | Shipping  Payments | Accounts &Privacy | Emails  Integration | Advanced  AxeptaConfiguration  Liste des abonnements avec Axepta
Ajouter un compte
Comptes Axepta
Ne Compte Marchand ID Pays Statut
BNP_Quadra_ebr_ EUR t Tous les pays [ @)
2 BNP_Quadra_tebr EUR t Germany >

To add a new account, click on the "Add account” button (Ajouter un compte)

Ajouter un compte

You should, then, fill the required data provided by BNP Paribas and click on "Save".

Comptes Axepta

*Entrez votre Marchant ID ‘ ‘Ce: ID est fourni par Axepta

*Entrez votre mot de passe de ‘ ‘19 mot de passe est fourni par Axepta
cryptage

*Entrez votre HMAC-KEY \ lLa clé "HMAC KEY* est fournie par Axepta

*Entrez votre clé d"activation \La clé d'activation est fournie par Axepta

Enregistrer les paramétres

Once the configuration saved, you can click on "configuration" to manage the different payment methods and functionalities you would like to activate on
your shop.



Mes méthodes de paiements

*CB/VISA/Mastercard ® Oui () Non

*AMEX ®) Oui ) Non

*Sofort ® Oui () Non

*Paypal ®) Oui Non

*Cetelem 3X Non disponible dans votre offre, veuillez contacter Axepta.

*Cetelem 4X Non disponible dans votre offre, veuillez contacter Axepta.

*Devise autorisée EUR Devise sélectionnée dans la configuration de Woocommerce.

*Pays autorisés Tous les pays |

The payment methods that are displayed are the ones corresponding to your activation key.

The payment methods in grey correspond to those that are not part of your offer. You have the possibility to visualize the complete offer in order to see
everything that the Axepta module proposes.

You can now configure your account options.

Currency :

The currency indicated is the currency of your activation key. This data cannot be modified, it is only shown as an indication for the management of the
account.

Please note that you must activate the currency beforehand in the woocommerce backoffice. To do this, go to "WooCommerce" > “Settings” > "General"
and find the tab "Currency options' .



Currency options

The following options affect how prices are displayed on the frontend.

Currency [ 7] Euro (€) -
Currency position 7] Left -
Thousand separator 7]

Decimal separator 7] ,

Number of decimals 7] l > s

Country :

You can choose to activate the account either in all countries or in manually selected countries by holding down the ctrl key.

WooCommerce / Réglages /

*Devise autorisée Devise sélectionnée dans la configuration de Woocommerce.

*Pays autorisés

Sélectionnez le pays que vous souhatitez lier a votre compte

< Tous les pays

3DS .

This option allows you to activate 3DS authentication and indicate the minimum amount for 3DS transactions.

One-click payment :

This option allows you to activate the oneclick payment via registration of the payment method by the user in his customer account.
Subscription :

This option allows you to activate the subscription payment on the shop.

Rendering mode :

The display of the payment page is possible in 2 ways with the plugin:

® Redirection => External redirection of the user to the payment page
® iFrame => Displaying the payment page on the shop in an iFrame

Capture method :

This option allows you to choose the payment capture method:



® Automatic => The capture will be done automatically in the night.
® Manual => After a defined time, you can choose just after choosing this option the delay before the capture (Delay in hours before capture
(integer between 1 and 696)).

Options de Paiement

*Activer le 3D-Secure @ (® Oui

Meontant minimum pour lequel 4 Montant minimum pour gjouter le 3DS
activer le 3D-Secure

*Activer le paiementenun clic @ (® Oui

Non
*Activer I'abonnement @ (® Oui
Non
Page de Paiement
*Sélection et saisie des données Redirection » Redirection : Redirection externe vers lg page d t

paiement
bo

nage de paiement sur la

bancaires lors d'un paiement utique

o

=
Mol Cantiny Capturer le paiement automatiquement (par défaut)

*Activer ce compte Activer » Activer ou désactiver ce compte

Your account is now configured.

You can configure as many accounts as your BNP Paribas contract allows. To add an account, you must go to "Axepta payment configuration" and do the
same operations. The list of accounts will be updated with each new registration.

You can also disable a configuration.

Payment modes configuration

One-off payment

To activate the one-off payment, you must go to "WooCommerce" > "Settings" > "Payments" on the left side of the screen, and check "Axepta”.



General | | Products | Shipping | Payments = Accounts &Privacy | Emails | Integration = Advanced | Axepta Configuration | Liste des abonnements avec Axepta
I Facebook for WooCommerce is almost ready. To complete your configuration, complete the setup steps. [x]

I Heads up! Facebook for WooCommerce will soon discontinue support for WooCommerce 4.1. Please update WooCommerce to take advantage of the latest updates and features <]

Payment methods

Installed payment methods are listed below and can be sorted to control their display order on the frontend.

Method Enabled Description

= - v Direct bank transfer (I Take payments in person via BACS. More commenly known as direct bank/wire transfer

= AV Check payments (I Teke payments in person via checks. This offline gateway can also be useful to test purchases.
= AV Cashondelivery (I Heve your customers pay with cash (or by other means) upon delivery.

= A~ Paypal (I PayPal Standard redirects customers to PayPal to enter their payment information.

= A v Axepta- Payer avec Axepta Online BNP Paribas [ @)

= A Paiement par abonnement avec Axepta - Paiement par abonnement sécurisé avec Axepta Online BNP o«

Paribas

Save changes

When you click on the button on the right side, you can configure the payment by checking the "activation" box.

You can also enable the logs (this can help the support to analyse transactions).

Axepta

Activation [v] Activer le paiement simple

Activer les logs (| Activer les logs

Save changes

One-click payment
This functionnality allows your customers to save their payment methods data so that they can pay faster the next time.

You need to make sure that this option is enabled in your configuration ("WooCommerce" > "Axepta Configuration" > "Configuration" of the MID of your
shop.

Options de Paiement

*Activer le paiementenunclic @ (® Oui

The customer will be able to manage his saved cards in his personal account in the “My saved cards” tab :



Accueil Mon compte Page d’exemple Panier Validation de la commande

Subscriptions

Enable Subscription

You need to make sure that this option is enabled in your configuration ("WooCommerce" > "Axepta Configuration" > "Configuration" of the MID of your
shop.

*Activer I'abonnement @ (® Oui

) Non

Configuration
When the subscription functionality is enabled, it's possible to configure items to pay by subscription.

To do so, you should configure every item that can be paid by subscription, individually. Go to the menu on the left side of your screen > "Products” and
search for the product you would like to configure by writing its name or scrolling the list.

On the product sheet (when you click on the name of the product), you can go to the "pay by subscription” tab on the bottom right side of the screen.

And you can configure the following information:

Type : indicates if the item will be paid by subscription or standard payment.

Periodicity : indicated the type of subscription (monthly or daily)

Interval occurrence : Number of times that the payment will be proceeded. If this value is not filled, the occurrence is unlimited.

Recurring amount : Indicated the amount of the item in subscription, so this value can be different from the initial price of the item. This value
represents the value that will be withdrawn in the future transactions.



Paiement par abonnement "

Type
| Paiement par abonnement A |

Pericdicité
E l

Type d'ocourence

| Month v |

Mombre dooourences {0 = illimite)

[ Mb souhaité occurences ]

Montant de I'abonnernent

[ Mortant HT de I'abo l

Subscriptions management

On the tab "Woocommerce" > "Settings" > "Listes des abonnements avec Axepta" , you can visualize all your subscriptions and have access to the
following data :

Customer name

Product ordered

Amount

Periodicity

Order date

Number of payments proceeded
Subscription status

Liste des abonnements aves Axepta

Cient Produit Type Prie d¢ Periodichi Date de s Derier paement  Staftut Actiors
: eoenmanss

Alme Lesitsr Beanie Aborament 500 € 1 our BV 200 v X @8
e sicar Car aborremet 1000 € 10 Jours En cours v X @& F
alne [esiens Bemie abareement S0 et 2 En cours v X @ §F
e Deamie Azorrement 500 € 12 Jours 2y T 20 En cours v X ®&F
aine Lesieat besie alareement 00 € Muit 205200 0003 r2020 Anendé v x ® N
Aine Lasiar e ADOTAMETT S0 € our RORIR2030 1 A3 20 fnml v X @ §
idine Lesiesr beanit sbomemert 240 € 3 rour 2000 [ 0V E0E0 En enurs v x & §F
i pe— sone — — : — v X ®H
e FrA— 00 § 5 ours 20032028 Bn cours v X ® N
A Beanie Aborrmet 500 & 5 Jours 2oMmER020 8 Cours v X @ W
dline | psipar Beanip Aboreament SO0 E 5 jours 20RO @ TR e v X @ -'

Available actions in this section are:
Enable a subscription
Disable a subscription
Check détails about an order

Delete a subscription



Actions

vV X ®§

Subscription management (user view / Front office)
The customer can also manage his subscriptions in his personnal account via the tab “My payments with subcription".

He can also enable/disable any subscription instantly by clicking on the button in the "Action" column.

Mes abonnements

Tableau de Paiement(s)
Demnier Prochain
bord Statut Produit o g 2 par Action
Your Orders
Activé Cap 03/20/20 04/19/20 12
Cartes de
paiement Activé Beanie 03/20/20 03/20/21 12 P

Abonnements &

Activé Beanie 03/20/20 04/01/20 7 P
Téléchargement Désactivé Beanie 03/20/20 3 =
Adresses Désactivé Beanie 03/22/20 - .
Account Details Acties Des e 03/25/20 MHtimité Annuler
Déconnexion Désactivé Beanie 03/20/20
Activé Beanie 03/20/20 03/25/20 illimité Pt
Activé Beanie 03/20/20 03/25/20 limité —

The subscription's status will be updated automatically on the backoffice.

Tents avec Axepta
[ Produit -. v] [ Périodicité v] :'Déb\.r... ]E:Fin | [ Ee—
Produit Type Prix de Périndicité Diate de la Nb paierrient(s) Dernier paierment Statut Ac
Fabonnement commande validéls|
Cap Abannement 10.00 € 30 Jours 20/02/2020 o 20/03/2020 v X
Beanie Aboanement 500¢€ 12 Mois 20/03/2020 [3 20,03/2020 oy v X

Transactions management

The complete list of transactions paid with different payment methods is available on the transactions tab : "Woocommerce" > "Transactions" . You will get,
for every transaction, the following information :

Transaction's date

Payment method's brand



Transaction ID

Order's reference

Merchant's Id

Pay ID

XID

Amount

Transaction's type (one-off payment, cancellation, refund, recurring payment...)
Status(success, failure, authorization... )

Response code

Details

Transactions

M Trangaction  N°Commands  Marchand ID PayiD X0 CCEiry Montart

288 - ' | 500 wauming o
A FMDWYR EN 45,00 refund oK
ATDSWKFLINMY 10 ".:'.l 4300 payment L

INTOIMDVRR 10 e fosaeds W o % 14300 parmest o

Message de
panse

Code de
répense

00000000

Dornées brutes

Datais

When you click on "Details" you will have additional information about the transaction (useful to analyze a transaction by the support)

Raw data detail - Transaction n° 46

Facebook for WooCommerce is almost ready. To complete your configuration, complete the setup steps.

OK : Successful transaction. Action code can contain information.

mid : BNP j

1 PayiD : 6ddd

TXID - 149¢

Trans|D : 2A63CJELVKXQP

Code : 00000000

Description - success

Refund/ cancellation

To make a refund, go to "Woocommerce" > "Orders". You will get the complete list of orders.



Orders

I Facebook for WooCommerce is almost ready. To complete your configuration, complete the setup steps. [x]
I Heads up! Facebook for WoaCommerce will soon discontinue support for WooCommerce 4.1. Please update WooCommerce to take advantage of the latest updates and features (<]
Al (33) | Processing (16) | Cancelled (4) | Refunded (1) | Failed (12) H Search orders
l Bulk Actions I All dates v Filter by re - 33 tems
O Order Date Status Total
] #89 Julien Brouwers Sep 17,2020 Cancelled €1800
] #8g Julien Brouwers ~  sep 17,2020 Processing €1800
] #87 Julien Brouwers ~  Sep 16,2020 Failed €1800
Once you select one order (by clicking on the name), you will get the following screen :
Edit order
I Facebook for WooCommerce is almost ready. To complete your configuration, complete the setup steps.
I Heads up! Facebook for WooCommerce will soon discontinue support for WooCommerce 4.1, Please update WooCommerce to take advantage of the latest updates and features.
Order #89 details
Payment via Payer avec Axepta Online BNP Paribas. Customer IP: 159.50.16.162
General Billing ¢ Shipping ’
Date created: § Julien Brouwers Address:
2020-09-17 |@| 1 | 27 ‘ 43 rue de paris No shipping address set.
— 59000 LILLE
Status:
Email address:
Cancelled - julien.brouwers@quadra-informatique.fr
Customer: Profile — View other orders — Phone:
0606060606
admin #1 — julien.brouwers@quadra-informatique fr) x ¥
Item Cost Qty Total
i Bonnet €18,00 =1 €18,00
Items Subtotal: €13,00
Order Total: €13,00

@ This order is no longer editable.

When you click on "Refund”, a new tab will appear allowing you to fulfill information about the refund :

= Amount : total amount or partial amount to refund. (The amount indicated can't be higher the total amount)
® Reason : this information is optional.



Restock refunded items: (v
amount already refunded: -€£0,00

Total available to refund; €18,00

©® Refund amount; | |

@ Reason for refund (optional): | |

Refund €0,00 manually Refund €0,00 via Axepta

You can now validate the refund.

Are you sure you wish to process this refund? This action cannot be undone.

Annuler

The transaction is now refunded.

| Rembaoursement

And the status is automatically updated to “remboursée”.

Commandes | Abuter une wmmande

Tous 20] | En cours (18] | Anudies (%) | Remboursées () | Echowdes (13
[ bctor grootes | [ bne | | ottt 3=
e 3 fta
0 - 0 M
e - 0w
- w20 M 2020 Echowdn
i - 0 M

Description of payment methods

Logo Nom @ Catégorie = Région Pays
d'émission

-140,00¢
Expéditian ! 5,00€
Tatal: 142.00¢ 0.00€
Remboursé: -146,00€

© Cetle commuonde n'est plus modifiatie

40 edmants 1 |swr2

Devises



E2 Alipay

AMERICAN
EXPRESS

Bancontact

masteroard

Alipay

American
Express

Banconta
ct

CB

Cetelem
Full CB

Cetelem
Presto

EPS

Finnish
Online
Banking

Giropay

IDEAL

Klarna

Mastercard

Multibanco

MyBank

Paypal

Wallet

Carte

Carte

Carte

BNPL

BNPL

Virement

Virement

Virement

Virement

BNPL

Carte

Virement

Virement

Wallet

APAC

International

Europe

France

Europe

Europe

Europe

Europe

Europe

Europe

Europe

International

Europe

Europe

International

France ; ltalie ; Belgique ; Luxembourg ; Royaume-Uni ;
Irlande ; Pays-Bas ; Espagne ; Allemagne ; Portugal ;
Suisse ; Autriche ; Slovaquie ; Slovénie ; Suéde ;
Danemark ; Norvége ; Finlande ; Estonie ; Lituanie ;
Lettonie ; Gréce

France ; ltalie ; Belgique ; Luxembourg ; Royaume-Uni ;
Irlande ; Pays-Bas ; Espagne ; Allemagne ; Portugal ;
Suisse ; Autriche ; Slovaquie ; Slovénie ; Suéde ;
Danemark ; Norvege ; Finlande ; Estonie ; Lituanie ;
Lettonie ; Grece

Belgique

France

France

France

Autriche

Finlande

Allemagne

Pays-Bas

Suéde ; Danemark ; Norvege ; Finlande

France ; ltalie ; Belgique ; Luxembourg ; Royaume-Uni ;
Irlande ; Pays-Bas ; Espagne ; Allemagne ; Portugal ;
Suisse ; Autriche ; Slovaquie ; Slovénie ; Suede ;
Danemark ; Norvége ; Finlande ; Estonie ; Lituanie ;
Lettonie ; Grece

Portugal

Italie

France ; ltalie ; Belgique ; Luxembourg ; Royaume-Uni ;
Irlande ; Pays-Bas ; Espagne ; Allemagne ; Portugal ;
Suisse ; Autriche ; Slovaquie ; Slovénie ; Suéde ;
Danemark ; Norvege ; Finlande ; Estonie ; Lituanie ;
Lettonie ; Gréce

AUD ; CAD;

EUR ; GBP;

HKD ; SGD ;
UsD

EUR ; GBP;
CHF ; USD ;
AUD ; CAD ;
DKK ; JPY ;
NOK ; PLN;
SEK

EUR

EUR

EUR

EUR

EUR

EUR

EUR

EUR

EUR; GBP;
CHF ; DKK;
USD; CAD;
NOK ; SEK ;
PLN

EUR ; GBP;
CHF ; DKK;
USD ; CAD;
JPY ; NOK ;
SEK ; PLN ;
AUD

EUR

EUR

EUR; GBP;
USD ; CAD


https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=91488388
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=91488426
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=91488426
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=91488981
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=91488981
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=89194497
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=91488502
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=91488502
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=91488521
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=91488521
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=91488616
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=93028508
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=93028508
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=93028508
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=91488654
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=91488692
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=91488749
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=93028554
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=91488806
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=93028573
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=89718791

Paysafec Prépayé International France ; Italie ; Belgique ; Luxembourg ; Royaume-Uni ; AUD ; CAD;
p ag s afE 1 | ard Irlande ; Pays-Bas ; Espagne ; Allemagne ; Portugal ; CHF ; EUR ;
Suisse ; Autriche ; Slovaquie ; Slovénie ; Suede ; GBP ; NOK ;
Danemark ; Norvége ; Finlande ; Estonie ; Lituanie ; PLN ; RON;
Lettonie ; Gréce SEK ; USD
Przelewy Virement Europe Pologne PLN
24
Przelewy
Visa Carte International France ; Italie ; Belgique ; Luxembourg ; Royaume-Uni ; EUR ; GBP;
Irlande ; Pays-Bas ; Espagne ; Allemagne ; Portugal ; CHF ; DKK;
Suisse ; Autriche ; Slovaquie ; Slovénie ; Suéde ; USD ; CAD;
Danemark ; Norvége ; Finlande ; Estonie ; Lituanie ; JPY ; NOK ;
Lettonie ; Grece SEK; PLN;
AUD
WeChat Wallet APAC France ; Italie ; Belgique ; Luxembourg ; Royaume-Uni ; EUR ; GBP;
- Pay Irlande ; Pays-Bas ; Espagne ; Allemagne ; Portugal ; UsD
n? »
G Il"wl{— (—hdl Pa}'r Suisse ; Autriche ; Slovaquie ; Slovénie ; Suede ;

Danemark ; Norvége ; Finlande ; Estonie ; Lituanie ;
Lettonie ; Gréce


https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=93028649
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=93028649
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=93028687
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=93028687
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=91488901
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=91488920
https://docs.axepta.bnpparibas/pages/viewpage.action?pageId=91488920
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